
 

 
МИНИСТЕРСТВО НАУКИ И ВЫСШЕГО ОБРАЗОВАНИЯ РОССИЙСКОЙ ФЕДЕРАЦИИ 

(МИНОБРНАУКИ РОССИИ) 

ФЕДЕРАЛЬНОЕ ГОСУДАРСТВЕННОЕ БЮДЖЕТНОЕ  

ОБРАЗОВАТЕЛЬНОЕ УЧРЕЖДЕНИЕ ВЫСШЕГО ОБРАЗОВАНИЯ 

«ДОНБАССКИЙ ГОСУДАРСТВЕННЫЙ ТЕХНИЧЕСКИЙ УНИВЕРСИТЕТ» 

(ФГБОУ ВО «ДонГТУ») 

 

Факультет информационных технологий и автоматизации производ-

ственных процессов 

Кафедра информационных технологий 

 

 

УТВЕРЖДАЮ 

и.о. проректора по учебной работе 

______________  Д.В. Мулов  

 

 

 

 

 

 

 

  РАБОЧАЯ ПРОГРАММА ДИСЦИПЛИНЫ 

 

Инструментальные средства компьютерной графики 
(наименование дисциплины) 

38.03.05 Бизнес-информатика 
(код, наименование направления/специальности) 

Электронный бизнес 
(профиль подготовки) 

 

 

 

 

 

 

 

Квалификация бакалавр 

 
(бакалавр/специалист)

 

Форма обучения очная 

 (очная, очно-заочная, заочная) 

 

 

 

 

Алчевск, 2024 

Документ подписан простой электронной подписью
Информация о владельце:
ФИО: Вишневский Дмитрий Александрович
Должность: Ректор
Дата подписания: 30.04.2025 11:55:50
Уникальный программный ключ:
03474917c4d012283e5ad996a48a5e70bf8da057



2  

 

1 Цели и задачи изучения дисциплины 

Цели дисциплины. Целью освоения дисциплины «Инструментальные 

средства компьютерной графики» является обеспечение современными зна-

ниями, умениями и навыками работы с растровой, векторной графикой, си-

стемами обработки видеоизображения. 

Задачи изучения дисциплины. Задачами освоения дисциплины «Ин-

струментальные средства компьютерной графики» является изучение мате-

матических и алгоритмических основ компьютерной графики, а также прак-

тическое освоение инструментальных средств и технологий компьютерной 

графики, методов построения, обработки и анализа изображений. 
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2 Место дисциплины в структуре ОПОП ВО 

Логико-структурный анализ дисциплины «Инструментальные средства 

компьютерной графики» – курс входит в элективные дисциплины части Бло-

ка 1, формируемые участниками образовательных отношений дисциплин 

подготовки студентов по направлению подготовки 38.03.05 «Бизнес-

информатика» (профиль: «Электронный бизнес»). 

Дисциплина реализуется кафедрой информационных технологий. 

Основывается на базе дисциплин: «Информатика», «Основы програм-

мирования». 

Является основой для изучения следующих дисциплин: «Преддиплом-

ная (производственная) практика». 

Для изучения дисциплины необходимы компетенции, сформированные 

у студента для реализации профессиональных задач деятельности, связанных 

с применением информационных и цифровых технологий при создании но-

вых цифровых продуктов и ИТ-сервисов.  

Курс является фундаментом для формирования информационной куль-

туры студентов и способствует развитию структурного стиля мышления. 

Общая трудоемкость освоения дисциплины составляет 3 зачетных еди-

ницы, 108 ак.ч.  

Программой дисциплины предусмотрены: 

– при очной форме обучения – лекционные (36 ак.ч.), практические 

(24 ак.ч.) занятия и самостоятельная работа студента (48 ак.ч.). 

Дисциплина изучается при очной форме обучения на 4-м курсе в 8-м 

семестре. 

Форма промежуточной аттестации – зачет. 
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3 Перечень результатов обучения по дисциплине, соотнесенных с 

планируемыми результатами освоения ОПОП ВО 

Процесс изучения дисциплины «Инструментальные средства компью-

терной графики» направлен на формирование компетенций, представленных 

в таблице 1. 

 

Таблица 1 – Компетенции, обязательные к освоению 

 

Содержание  

компетенции 

Код 

компетен-

ции 

Код и наименование индикатора 

достижения компетенции 

Способен организо-

вывать взаимодей-

ствие с клиентами и 

партнерами в про-

цессе решения задач 

управления жизнен-

ным циклом инфор-

мационных систем и 

информационно-

коммуникационных 

технологий 

ОПК-5 ОПК-5.2. Демонстрирует навыки командной рабо-

ты  

Способен применять 

информационные и 

цифровые техноло-

гии при создании 

новых бизнес-

моделей, цифровых 

продуктов, ИТ-

сервисов и совер-

шенствовании биз-

нес-процессов 

ПК-3 ПК-3.2. Владеет инструментальными средствами 

для организации и управления электронным биз-

несом  
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4 Объём и виды занятий по дисциплине 

Общая трудоѐмкость учебной дисциплины составляет 3 зачетных еди-

ницы, 108 ак.ч.  

Самостоятельная работа студента (СРС) включает проработку матери-

алов лекций, подготовку к практическим занятиям, текущему контролю, са-

мостоятельное изучение материала и подготовку к промежуточной аттеста-

ции в виде зачета. 

При организации внеаудиторной самостоятельной работы по данной 

дисциплине используются формы и распределение бюджета времени на СРС 

для очной формы обучения в соответствии с таблицей 2. 

 

Таблица 2 – Распределение бюджета времени на СРС 

 

Вид учебной работы Всего ак.ч. 

Ак.ч. 

 по семестрам 

8 

Аудиторная работа, в том числе: 60 60 

Лекции (Л) 36 36 

Практические занятия (ПЗ) 24 24 

Лабораторные работы (ЛР) - - 

Курсовая работа/курсовой проект - - 

Самостоятельная работа студентов (СРС), в том числе: 48 48 

Подготовка к лекциям 9 9 

Подготовка к лабораторным работам - - 

Подготовка к практическим занятиям / семинарам 13 13 

Выполнение курсовой работы / проекта - - 

Расчетно-графическая работа (РГР) - - 

Реферат (индивидуальное задание) - - 

Домашнее задание - - 

Подготовка к контрольным работам - - 

Подготовка к коллоквиуму - - 

Аналитический информационный поиск 9 9 

Работа в библиотеке 9 9 

Подготовка к зачету 8 8 

Подготовка к экзамену - - 

Промежуточная аттестация – зачет (З) З З 

Общая трудоемкость дисциплины 

ак.ч. 108 108 

з.е. 3 3 
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5 Содержание дисциплины 

 

С целью освоения компетенций, приведенных в п.3 дисциплина 

«Инструментальные средства компьютерной графики» разбита на 5 тем: 

– тема 1 (Введение в компьютерную графику); 

– тема 2 (Общие сведения об инструментальных программных сред-

ствах); 

– тема 3 (Графический редактор Adobe Photoshop); 

– тема 4 (Графический редактор CorelDRAW); 

– тема 5 (3D моделирование). 

 

Виды занятий по дисциплине и распределение аудиторных часов для 

очной формы обучения приведены в таблице 3. 
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Таблица 3 – Виды занятий по дисциплине и распределение аудиторных часов (очная форма обучения) 

 

№ 
п/п 

Наименование  
темы (раздела)  
дисциплины 

Содержание  
лекционных занятий 

Трудоемкость 
в ак.ч. 

Темы  
практических  

занятий 

Трудоемкость 
в ак.ч. 

Тема 
лабораторных  

занятий 

Трудоемкость 
в ак.ч. 

1 Введение в 

компьютерную 

графику. 

Определение, основные задачи 

компьютерной графики. 

Применение интерактивной 

графики в информационных 

системах. Классификация видов 

компьютерной графики. 

Рендеринг и этапы получения 

изображения. Сферы 

применения компьютерной 

графики. Краткая история 

компьютерной графики. 

6 

Растровый редактор 

Photoshop 

4 - - 

2 Общие сведения 

об инструмента-

льных програм-

мных средствах 

Понятие инструментальных 
программных средств, их состав. 
Текстовые редакторы. 
Графические редакторы. 

6 

Выполнение 

сложного коллажа в 

Photoshop 
4 - - 

3 Графический 

редактор Adobe 

Photoshop 

Настройка интерфейса. Понятие 
«рабочее пространство». Созда-
ние нового изображения. Изме-
нение основных параметров 
изображений. Приемы выделе-
ния областей сложной формы. 
Создание многослойного изо-
бражения. Работа со слоями. 
Параметры слоя. Особенности 
работы с многослойным изобра-
жением. Сохранение много-
слойного файла. Трансформа-
ция содержимого слоя. 

8 

Графический 

редактор 

CorelDRAW: 
Выполнение 

индивидуальных 

заданий: создание 

графического 

изображения с 

помощью 

примитивов. 
 

4 - - 

 
1

3
 

7
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№ 
п/п 

Наименование  
темы (раздела)  
дисциплины 

Содержание  
лекционных занятий 

Трудоемкость 
в ак.ч. 

Темы  
практических  

занятий 

Трудоемкость 
в ак.ч. 

Тема 
лабораторных  

занятий 

Трудоемкость 
в ак.ч. 

4 Графический 

редактор 

CorelDRAW 

Настройка интерфейса. Объекты. 
Работа с цветом. Способы окра-
шивания объектов. Управление 
прозрачностью объекта. Средст-
ва повышенной точности. Испо-
льзование линеек, сетки и напра-
вляющих. Точные преобразова-
ния объектов. Выравнивание и 
распределение объектов. Разра-
ботка фирменного стиля. Плани-
рование макета. Создание лого-
типов. Правила оформления виз-
иток. Работа с текстом. Обзор 
спецэффектов. Практика совме-
щения векторных и растровых 
изображений. 

8 

Графический 

редактор 

CorelDRAW: 
создание логотипов, 

разработка 

фирменных бланков и 

визитки. 

6 - - 

5 3D 

моделирование 

Навигация в окне. Выделение 
объектов. Изменение позиции, 
размера и угла поворота объек-
тов. Добавление объектов. 
Режимы объектный и редакти-
рования. Редактирование вер-
шин, рѐбер и граней. Объедине-
ние объектов. Экструдирова-
ние. Булевы операции и моди-
фикаторы. Зеркальное отобра-
жение. Сглаживание объектов. 
Добавление материала. Свойст-
ва материала. Текстуры. 

8 

3D моделирование: 

создание в Blender 

сцену, в которой бы 

материалы объектов 

обладали свойствами 

прозрачности, могли 

отражать другие 

предметы, совмещали 

оба свойства 

6 - - 

Всего аудиторных часов 36 24 - 
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6 Фонд оценочных средств для проведения текущего контроля 

успеваемости и промежуточной аттестации по итогам освоения 

дисциплины 

6.1 Критерии оценивания 

В соответствии с Положением о кредитно-модульной системе органи-

зации образовательного процесса ФГБОУ ВО «ДонГТУ» 

(https://www.dstu.education/images/structure/license_certificate/polog_kred_modu

l.pdf) при оценивании сформированности компетенций по дисциплине ис-

пользуется 100-балльная шкала. 

Перечень работ по дисциплине и способы оценивания знаний приведе-

ны в таблице 4. 
 

Таблица 4 – Перечень работ по дисциплине и способы оценивания знаний 
 

Вид учебной работы Способ оценивания Количество баллов 

Выполнение  
практических работ 

Предоставление  
отчетов 

24 - 40 

Выполнение тестового кон-
троля или устного опроса 

Более 60% правильных 
ответов 

36 - 60 

Итого - 60-100 

Зачет проставляется автоматически, если студент набрал не менее 

60 баллов и отчитался за каждую контрольную точку. Минимальное количе-

ство баллов по каждому из видов текущей работы составляет 60% от макси-

мального. 

Зачет по дисциплине проводится по результатам работы в семестре. В 

случае, если полученная в семестре сумма баллов не устраивает студента, то-

гда во время зачетной недели или в течении экзаменационной сессии студент 

имеет право повысить итоговую оценку либо в форме устного собеседования 

по приведенным ниже вопросам (п. 6.3), либо в результате тестирования 

(п. 6.2). 

Шкала оценивания знаний при проведении промежуточной аттестации 

приведена в таблице 5. 

Таблица 5 – Шкала оценивания знаний  
 

Сумма баллов за все виды 

учебной деятельности 

Оценка по национальной шкале 

зачѐт/экзамен 

0-59  Не зачтено/неудовлетворительно 

60-73 Зачтено/удовлетворительно 

74-89 Зачтено/хорошо 

90-100 Зачтено/отлично 

1
2
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6.2  Примерные оценочные средства (тесты) для текущего кон-

троля успеваемости  

Таблица 6 – Примерные тесты для текущего контроля успеваемости  

№ 

п/п 
Содержание вопроса Варианты ответа 

Тема 1. Введение в компьютерную графику 

1 Что такое пиксель? а) элемент изображения; 

б) единица измерения разрешения; 

в) название компьютерной программы. 

2 Какие бывают форматы 

изображений? 

а) JPG, PNG, GIF; 

б) Word, Excel, PowerPoint; 

в) PDF, DOCX, XLSX. 

3 Что такое RGB? а) модель цвета; 

б) тип шрифта; 

в) категория файлов. 

4 Какой программой можно 

создавать векторные 

изображения? 

а) Adobe Illustrator; 

б) Adobe Photoshop; 

в) CorelDRAW. 

5 Как называют способ-

ность устройства показать 

большое количество цве-

тов одновременно? 

а) глубина цвета; 

б) разрешение; 

в) яркость. 

6 Что такое растровая гра-

фика? 

а) изображение, созданное на основе пикселей; 

б) изображение, созданное на основе векторов; 

в) изображение, созданное в 3D графике. 
7 Какие программы исполь-

зуются для создания 3D 

моделей? 

а) Autodesk Maya, Blender; 

б) Adobe Photoshop, CorelDRAW; 

в) Microsoft Word, Excel. 

8 Как называется процесс 

преобразования 2D изо-

бражения в 3D? 

а) моделирование; 

б) текстурирование; 

в) анимация. 

9 Какие инструменты поз-

воляют создавать анима-

цию? 

а) Adobe Animate, After Effects; 

б) Adobe Illustrator, CorelDRAW; 

в) AutoCAD, 3ds Max. 

10 Как называется процесс до-

бавления текстур, освеще-

ния и теней к 3D модели? 

а) текстурирование; 

б) моделирование; 

в) анимация. 

Тема 2. Общие сведения об инструментальных программных средствах 

1 Что представляют собой 

инструментальные про-

граммные средства? 

а) программы, позволяющие выполнять различные задачи; 

б) аппаратные устройства для обработки информации; 

в) управляющие системы компьютера. 

2 Какие основные виды 

инструментальных про-

граммных средств суще-

ствуют? 

а) графические редакторы, текстовые редакторы, антиви-

русные программы; 

б) системы управления базами данных, аналитические 

программы, программы для работы с документами; 

в) калькуляторы, браузеры, почтовые клиенты. 
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№ 

п/п 
Содержание вопроса Варианты ответа 

3 Какие преимущества 

имеют инструменталь-

ные программные сред-

ства? 

а) ускорение выполнения задач, повышение точности ре-

зультатов, автоматизация процессов; 

б) улучшение работы аппаратного обеспечения, увеличе-

ние объема памяти, улучшение интерфейса; 

в) уменьшение стоимости программного обеспечения, по-

вышение безопасности, улучшение производительности. 

4 Какие задачи могут вы-

полнять инструменталь-

ные программные сред-

ства? 

а) анализ данных, моделирование процессов, автоматиза-

ция работы; 

б) создание программ для игр; 

в) проведение экспериментов. 

5 Какой программный про-

дукт относится к инстру-

ментальным средствам 

компьютерной графики? 

а) Microsoft Word; 

б) Adobe Photoshop; 

в) Microsoft Excel. 

6 Что такое масштабирова-

ние изображения и какие 

методы его можно ис-

пользовать в графических 

редакторах? 

а) изменение размера изображения; 

б) изменение угла наклона; 

в) все вышеперечисленное. 

7 Какие эффекты можно 

создать с помощью ин-

струментальных про-

граммных средств ком-

пьютерной графики? 

а) размытие; 

б) искажение; 

в) все вышеперечисленное. 

8 Какие принципы необхо-

димо учитывать при рабо-

те с цветом в компьютер-

ной графике? 

а) цветовая модель; 

б) цветовой профиль; 

в) цветовое кодирование. 

9 Какой формат файла ис-

пользуется для хранения 

растровых изображений? 

а) JPEG; 

б) PNG; 

в) PGN. 

10 Какие инструменты ис-

пользуются для создания 

анимации в компьютер-

ной графике? 

а) кадрирование; 

б) таймлайн; 

в) ролевые кадры. 

Тема 3. Графический редактор Adobe Photoshop 

1 Какой инструмент в 

Photoshop используется 

для выделения объектов 

на изображении? 

а) кисть; 

б) лассо; 

в) градиент; 

г) резак. 

2 Какая комбинация кла-

виш используется для 

отмены последнего дей-

ствия в Adobe Photoshop? 

а) Ctrl + Z; 

б) Ctrl + C; 

в) Ctrl + S; 

г) Ctrl + A. 

3 Какой инструмент в 

Photoshop используется 

для наложения текста на 

изображение? 

а) кисть; 

б) текст; 

в) градиент; 

г) резак. 
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4 Какая комбинация кла-

виш используется для 

сохранения файла в 

Adobe Photoshop? 

а) Ctrl + Z; 

б) Ctrl + C; 

в) Ctrl + S; 

г) Ctrl + A. 

5 Какой инструмент в 

Photoshop используется 

для ретуширования 

портретов? 

а) кисть; 

б) резак; 

в) ластик; 

г) лекало. 

6 Какая функция в 

Photoshop используется 

для изменения размера 

изображения без потери 

качества? 

а) сжатие; 

б) масштабирование; 

в) поворот; 

г) отражение. 

7 Какой инструмент в 

Photoshop используется 

для добавления эффек-

тов к изображению? 

а) кисть; 

б) фильтр; 

в) ластик; 

г) линейка. 

8 Какая комбинация кла-

виш используется для 

выделения всего изоб-

ражения в Photoshop? 

а) Ctrl + Z; 

б) Ctrl + C; 

в) Ctrl + S; 

г) Ctrl + A. 

9 Какой инструмент в 

Photoshop используется 

для коррекции цветового 

баланса на изображении? 

а) кисть; 

б) пипетка; 

в) градиент; 

г) заливка. 

10 Каким форматом сохра-

няются файлы в Adobe 

Photoshop со всеми сло-

ями и эффектами? 

а) PNG; 

б) JPEG; 

в) TIFF; 

г) PSD. 

Тема 4. Графический редактор CorelDRAW 

1 Чем отличается Corel-

DRAW от Adobe Illustra-

tor? 

а) CorelDRAW имеет другой интерфейс; 

б) CorelDRAW работает только на ПК; 

в) CorelDRAW использует другой формат файлов; 

г) все перечисленные. 

2 Какая функция помогает 

быстро изменить размер 

объекта в CorelDRAW? 

а) инструмент «Масштабирование»; 

б) клавиша Ctrl; 

в) клавиша Shift; 

г) функция «Авто-размер». 

3 Какие из перечисленных 

форматов файлов под-

держивает CorelDRAW? 

а) JPG; 

б) EPS; 

в) AI; 

г) все вышеперечисленные. 

4 Какой инструмент ис-

пользуется для создания 

кривых линий в 

CorelDRAW? 

а) инструмент «Карандаш»; 

б) инструмент «Линия»; 

в) инструмент «Кривая»; 

г) инструмент «Фигуры». 

5 Какие эффекты можно 

применить к объекту в 

а) размытие; 

б) заливка градиентом; 
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CorelDRAW? в) тени; 

г) все вышеперечисленное. 

6 Какая команда использу-

ется для объединения 

нескольких объектов в 

один в CorelDRAW? 

а) команда «Объединение»; 

б) команда «Группирование»; 

в) команда «Объединить с образцом»; 

г) команда «Слияние». 

7 Как создать текстовый 

блок в CorelDRAW? 

а) нажать на кнопку «Текст»; 

б) использовать инструмент «Текст»; 

в) вставить текст из буфера обмена; 

г) вставить текстовый файл. 

8 Какие опции доступны 

при работе с цветом в 

CorelDRAW? 

а) выбор изображения цвета; 

б) использование красных, зеленых и синих каналов; 

в) настройка оттенка, насыщенности и яркости; 

г) все вышеперечисленное. 

9 Как сохранить проект в 

CorelDRAW? 

а) выбрать «Файл» → «Сохранить»; 

б) нажать на кнопку «Сохранить»; 

в) использовать хоткеи; 

г) нажать на кнопку «Экспорт». 

10 Какие инструменты до-

ступны для редактирова-

ния изображения в 

CorelDRAW? 

а) инструмент «Выделение»; 

б) инструмент «Поворот»; 

в) инструмент «Клональный»; 

г) все вышеперечисленное. 

Тема 5. 3D моделирование 

1 Какое расширение име-

ют файлы проектов 

Blender? 

а) .blend; 

б) .obj; 

в) .fbx; 

г) .stl. 

2 Какая кнопка отвечает за 

создание нового объекта 

в Blender? 

а) Shift + A; 

б) Ctrl + N; 

в) Alt + S; 

г) Esc. 

3 Какой режим позволяет 

изменять геометрию 

объектов в Blender? 

а) Edit Mode; 

б) Sculpt Mode.; 

в) Weight Paint Mode; 

г) Material Mode. 

4 Как добавить текстуру к 

объекту в Blender? 

а) использовать команду File → Import; 

б) перейти в Texture Paint Mode; 

в) использовать команду Add → Texture → Image Texture; 

г) просто перетащить текстуру на объект. 

5 Какая клавиша позволяет 

выделить все объекты в 

сцене Blender? 

а) A; 

б) S; 

в) V; 

г) X. 

6 Как изменить точку об-

зора камеры в Blender? 

а) используя кнопку Shift + C; 

б) перемещая объект камеры; 

в) нажав на кнопку View → Camera; 

г) изменить параметры в разделе Camera во вкладке 

Properties. 
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7 Как создать анимацию 

движения объекта в 

Blender? 

а) используя ручное перемещение объекта; 

б) добавив к объекту модификатор Animation; 

в) используя ключевые кадры (Keyframes); 

г) смоделировав движение вручную каждый кадр. 

8 Какая кнопка отвечает за 

отмену последнего дей-

ствия в Blender? 

а) Ctrl + Z; 

б) Ctrl + Y; 

в) Shift + R; 

г) Alt + F4. 

9 Каково функциональное 

назначение модификато-

ра Subdivision Surface? 

а) увеличение количества вершин объекта для более 

плавной формы; 

б) уменьшение количества полигонов объекта для опти-

мизации; 

в) добавление текстуры к объекту; 

г) ограничение движения объекта. 

10 Как добавить свет в сце-

ну Blender? 

а) используя кнопку Add → Light; 

б) перетащить объект света из панели инструментов; 

в) изменить настройки освещения в разделе World во 

вкладке Properties; 

г) просветить текстуру объекта. 

 

6.3 Примерные вопросы для подготовки к промежуточной аттеста-

ции (зачету)  

1) Что такое пиксель в контексте компьютерной графики?  

2) Какое устройство отвечает за отображение графики на экране? 

3) Что такое растр и в чем его отличие от векторной графики? 

4) Какие основные цвета используются в RGB-модели? 

5) Что такое разрешение изображения и как оно измеряется? 

6) Какой алгоритм применяется для рисования линий в 2D-графике?  

7) Что такое антьялисинг и как он улучшает качество изображения? 

8) Какое свойство векторной графики обеспечивает масштабируе-

мость?  

9) Что такое текстура, и как она используется в 3D-графике?  

10) Что такое рендеринг в компьютерной графике?  

11) Каково назначение шейдеров в современных графических при-

ложениях? 

12) Какие форматы файлов чаще всего используются для хранения 

растровых изображений? 

13) Какова роль графического процессора в обработке графики?  

14) Какие основные этапы включает процесс создания 3D-модели?  

15) Что такое полигоны и как они используются в 3D-графике? 

16) Каковы преимущества растра? 
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17) Каковы преимущества векторной графики? 

18) Каковы недостатки растра? 

19) Каковы недостатки векторной графики? 

20) Какие форматы файлов наиболее популярны для растра? 

21) Какие форматы файлов популярны для векторной графики? 

22) Какие факторы следует учитывать при выборе между растровой и 

векторной графикой? 

23) Каковы самые распространенные ошибки при выборе между 

растровой и векторной графикой? 

24) Какие факторы вы считаете наиболее важными при выборе гра-

фического формата? 

25) Какие факторы могут повлиять на выбор графического формата? 

26) Как вы думаете, какие форматы вы используете наибольшее ко-

личество раз? 

27) Какие форматы поддерживают лучшее качество при низком раз-

мере файла? 

28) Как вы предпочитаете хранить свои изображения? 

29) Какой формат хранения вы предпочитаете для изображений? 

30) Какие факторы вы учитываете при выборе формата для изобра-

жений? 

31) Какую роль для вас играет качество по сравнению с размером 

файла? 

32) Сталкивались ли вы с ситуациями, когда приходилось жертвовать 

качеством ради уменьшения размера файла? 

33) Что такое инструментальные программные средства для компью-

терной графики и какую роль они играют в создании графического контента?  

34) Назовите основные типы инструментальных программных 

средств для компьютерной графики и приведите примеры для каждого типа?  

35) Какова роль векторной графики в инструментальных программ-

ных средствах и какие программы наиболее часто используются для работы с 

векторной графикой?  

36) В чем отличие растровой графики от векторной графики и какие 

программы относятся к каждому из этих типов? 

37)  Какие основные форматы файлов используются для сохранения 

графических изображений и каковы их особенности?  

38) Как инструментальные средства для компьютерной графики мо-

гут быть использованы в области анимации и какие программы для этого 

наиболее популярны?  
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39) Объясните, что такое 3D-моделирование и какие инструменты 

наиболее популярны для этой задачи.  

40) Какое значение имеет цветовая модель при работе с инструмен-

тальными программными средствами для компьютерной графики?  

41) Какие навыки необходимы для эффективного использования ин-

струментальных программных средств в компьютерной графике?  

42) Каковы основные принципы работы с текстурами и материалами 

в 3D-графике?  

43) Назовите и объясните этапы процесса создания компьютерной 

графики от концепции до окончательной визуализации.  

44) Какие новейшие тренды в инструментальных программах для 

компьютерной графики вы можете выделить?  

45) Как конкуренция между различными программами влияет на раз-

витие технологий компьютерной графики?  

46) Каковы основные преимущества и недостатки использования об-

лачных сервисов для работы с графикой?  

47) Каков вклад открытых программных средств (open-source) в раз-

витие компьютерной графики? Опишите. 

48) Каковы перспективы развития программных средств для 3D-

моделирования? 

49) Какие технологии могут оказать наибольшее влияние на будущее 

3D-дизайна? 

50) Какие новые профессии могут возникнуть в связи с развитием 

технологий в этой области? 

51) Что такое Adobe Photoshop и для чего он используется?  

52) Какие основные форматы файлов поддерживает Adobe 

Photoshop?  

53) Какой инструмент позволяет выделять объекты на изображении?  

54) Как изменить размер изображения в Photoshop?  

55) В чем разница между векторной и растровой графикой в контек-

сте Photoshop?  

56) Как создать новый слой в документе Photoshop?  

57) Что такое маска слоя и как она применяется?  

58) Как изменить цвет изображения с помощью корректирующих 

слоев?  

59) Как сохранить изображение для веба в Photoshop?  

60) Какие основные приемы работы с текстом доступны в Adobe 

Photoshop?  
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61) Как можно улучшить резкость изображения в Photoshop?  

62) Для чего используется инструмент «Кисть» и как его настроить?  

63) Как создать градиент в Adobe Photoshop?  

64) Каковы основные возможности редактирования фотографий в 

Photoshop?  

65) Какие плагины могут улучшить функциональность Adobe 

Photoshop? 

66) Как вы думаете, какие навыки особенно важны для работы в 

Adobe Photoshop? 

67) Как вы считаете, какие другие навыки могут повысить эффектив-

ность работы в Photoshop? 

68) Используете ли вы плагины или расширения для повышения сво-

ей продуктивности в Photoshop? 

69) Какие плагины вы уже используете для повышения своей про-

дуктивности в Photoshop? 

70) Какую задачу вы хотите решить с помощью плагинов? 

71) Какое основное назначение программы CorelDRAW?  

72) Назовите основные форматы файлов, поддерживаемые 

CorelDRAW.  

73) Как создать новый документ в CorelDRAW?  

74) Опишите процесс импорта изображения в CorelDRAW. 

75) Как использовать инструмент «Перемещение» в CorelDRAW?  

76) В чем разница между растровой и векторной графикой?  

77) Как создать и настроить градиентный залив в CorelDRAW?  

78) Опишите процесс работы с текстом в CorelDRAW.  

79) Как применяется инструмент «Карандаш» для рисования в 

CorelDRAW?  

80) Что такое контуры и как с ними работать в CorelDRAW?  

81) Как наносить тени на объекты в CorelDRAW?  

82) В чем преимущества использования слоев в CorelDRAW?  

83) Как создать векторное изображение из растрового?  

84) Как экспортировать готовую работу в CorelDRAW в другие фор-

маты?  

85) Какие инструменты могут помочь в выравнивании объектов на 

рабочей области? 

86) Как правильно настроить рабочую область в CorelDRAW? 

87) Что такое 3D моделирование в компьютерной графике?  

88) Каковы основные этапы 3D моделирования?  
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89) Назовите три популярных программных пакета для 3D моделиро-

вания и коротко опишите их особенности?  

90) Что такое полигональная модель и как она отличается от других 

типов 3D моделей?  

91) Какова роль текстурирования в 3D моделировании?  

92) Что такое UV-развертка и почему она важна в процессе тексту-

рирования? 

93) В чем разница между параметрическим и полигональным моде-

лированием?  

94) Какие существуют типы освещения в 3D графике и как они вли-

яют на восприятие модели?  

95) Что такое рендеринг и какие основные методы рендеринга суще-

ствуют?  

96) Какова цель использования материалов в 3D моделировании?  

97) Что такое анимация в 3D моделировании и какие основные мето-

ды анимации существуют?  

98) Опишите, что такое сцена и ее компоненты в 3D моделировании.  

99) Каковы основные форматы файлов для хранения 3D моделей и их 

характеристик?  

100) Объясните, что такое нормали в 3D моделировании и как они 

влияют на освещение поверхности.  

101) Почему важен выбор программного обеспечения для 3D модели-

рования?  

102) Какие факторы следует учитывать при выборе программного 

обеспечения для 3D моделирования? 

6.4 Примерная тематика курсовых работ 

Курсовые работы не предусмотрены. 
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7 Учебно-методическое и информационное обеспечение дисциплины 

7.1 Рекомендуемая литература 

Основная литература 
1. Немцова, Т. И. Компьютерная графика и web-дизайн : учебное 

пособие / Т.И. Немцова, Т.В. Казанкова, А.В. Шнякин ; под ред. Л.Г. 
Гагариной. — Москва : ФОРУМ : ИНФРА-М, 2023. — 400 с. + Доп. 
материалы [Электронный ресурс]. — (Среднее профессиональное 
образование). — ISBN 978-5-8199-0790-0. — Текст : электронный. — URL: 
https://znanium.ru/catalog/product/1905248 (дата обращения: 13.07.2024). — 
Режим доступа: по подписке. 

Дополнительная литература 
1. Дорощенко, М.А. Программы Adobe. Основы программы Photoshop 

CC : метод. руководство / М. А. Дорощенко, Л.И. Миронова. — Москва : 
ФГОУ СПО "МИПК им. И.Федорова", 2018. — 64 с. — Текст : электронный. 
— URL: https://znanium.com/catalog/product/1039225 (дата обращения: 
13.07.2024). — Режим доступа: по подписке. 

2. Технология трехмерного моделирования и текстурирования объектов 
в Blender 3d и 3d Max : учебное пособие / А. А. Кузьменко, А. Д. Гладченков, 
В. А. Шкаберин [и др.]. — Москва : ФЛИНТА, 2019. — 142 с. — ISBN 978-5-
9765-4216-7. — Текст : электронный. — URL: 
https://znanium.com/catalog/product/1860054 (дата обращения: 13.07.2024). – 
Режим доступа: по подписке. 

3. Выполнение практических заданий в программе Corel Draw : мето-
дические указания / сост. С. С. Ахтямова, Р. Б. Ахтямов. — Казань : КНИ-
ТУ, 2018. — 80 с. — Текст : электронный. — URL: 
https://znanium.com/catalog/product/1895547 (дата обращения: 13.07.2024). — 
Режим доступа: по подписке. 

7.2 Базы данных, электронно-библиотечные системы, информаци-

онно-справочные и поисковые системы 

1. Научная библиотека ДонГТУ : официальный сайт.— Алчевск. —
URL: library.dstu.education.—Текст : электронный. 

2. Научно-техническая библиотека БГТУ им. Шухова : официальный 
сайт. — Белгород. — URL: http://ntb.bstu.ru/jirbis2/.—Текст : электронный. 

3. Консультант cтудента :электронно-библиотечная система.— Москва. 
— URL: http://www.studentlibrary.ru/cgi-bin/mb4x.—Текст : электронный. 

4. Университетская библиотека онлайн : электронно-библиотечная си-
стема.— URL: http://biblioclub.ru/index.php?page=main_ub_red.—Текст : элек-
тронный. 

5. IPR BOOKS : электронно-библиотечная система. — Красногорск. — 
URL: http://www.iprbookshop.ru/. — Текст : электронный. 

http://library.dstu.education/
http://ntb.bstu.ru/jirbis2/
http://www.studentlibrary.ru/cgi-bin/mb4x
http://biblioclub.ru/index.php?page=main_ub_red
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8 Материально-техническое обеспечение дисциплины 

Материально-техническая база обеспечивает проведение всех видов 

деятельности в процессе обучения, соответствует требованиям ФГОС ВО. 

Материально-техническое обеспечение представлено в таблице 7. 

Таблица 7 – Материально-техническое обеспечение 

Наименование  

оборудованных учебных кабинетов 

Адрес 

 (местоположение) 

учебных 

кабинетов 

Специальные помещения: 

Аудитории для проведения практических занятий, для самостоя-

тельной работы: 

Компьютерный класс с мультимедийным оборудованием: 

компьютер – 14 шт., мультимедийный проектор, проекционный 

экран, веб-камера, колонки, микрофон, учебная мебель (столы 

компьютерные; столы; стулья; доска для написания мелом) 

 
 
 

 

 

ауд. 412 корп. 2 
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